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ABOUT THIS MANUAL
The following symbols are used in this guide:

This symbol indicates a CAUTION. Cautions warn against actions that can cause 
damage to equipment. Please read these carefully.

This symbol indicates a WARNING. Warnings alert you to actions that can cause 
personal injury or pose a physical threat. Please read these carefully.

NOTES and TIPS contain helpful information.

Fig. 1—The LabTrax 8/16 is an 8-channel data acquisition system.

INTRODUCTION
The LabTrax 8/16 is a 16-bit analog to digital converter that can be programmed to 
activate as many as eight analog inputs, four analog outputs, 16 digital inputs and 16 
digital outputs. 

Parts List
After unpacking, verify that there is no visible damage to the instrument. Verify that all 
items are included:
(1) LabTrax 8/16
(1) MDAC Software CD
(1) Power Supply cable
(1) USB cable
(1) Instruction Manual

Unpacking
Upon receipt of this instrument, make a thorough inspection of the contents and 
check for possible damage. Missing cartons or obvious damage to cartons should be 
noted on the delivery receipt before signing. Concealed damage should be reported 
at once to the carrier and an inspection requested. Please read the section entitled 
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“Claims and Returns” on page 51 of this manual. Please contact WPI Customer 
Service if any parts are missing at 941.371.1003 or customerservice@wpiinc.com.

Returns: Do not return any goods to WPI without obtaining prior approval (RMA 
# required) and instructions from WPI’s Returns Department. Goods returned 
(unauthorized) by collect freight may be refused. If a return shipment is necessary, 
use the original container, if possible. If the original container is not available, use a 
suitable substitute that is rigid and of adequate size. Wrap the instrument in paper or 
plastic surrounded with at least 100mm (four inches) of shock absorbing material. For 
further details, please read the section entitled “Claims and Returns” on page 51 of 
this manual.

SOFTWARE INSTALLATION

Installing MDAC/DAQ Software
This installation installs both the MDAC software and the necessary National 
Instruments interface components.

1. Insert the MDAC installation CD into the computer CD drive and copy the CD 
content to your hard disk drive (C:\).

2. If the installation does not start automatically, use Windows Explorer to view the 
files Rn the &D. TR RSen Windows Explorer, right click on the Windows Start but-
ton and choose Explore. Navigate to the CD drive. 

Fig. 2—Double click on the Setup.exe file to install the MDAC software.

3. Double-click on the setup.exe file tR stDrt the LnstDllDtLRn RI the MDAC program. 
It is in the root directory of the CD. The Destination Directory window appears.
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Fig. 3—The first install window lets you choose the installation directories.

4. By default the software packages install in the C:\Program Files directory. 

TIP: To change one of the installation directories, click on the  button 
and choose another location. 
Click the  button. The license agreement displays.

Fig. 4—The National Instruments license agreement is on the NI tab, and the MDAC license 
agreement is on the M tab.
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5. After reading the license agreements for the National Instruments and MDAC
software, click the  button. The installation summary page displays.

Fig. 5—The installation summary window shows the files that will be installed.

6. Review the summary. Click the  button. The status indicator appears 
to show the progress of the installation.

Fig. 6—The installation window shows the status of the installation.
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7. When the installation is complete, the Installation Complete message displays.  
Click the  button. A message box appears indicating that you must 
restart the computer to complete the installation.

Fig. 7—When the installation is complete, click Finish.

8. Before running the software, you must restart the computer. Close all open pro-

grams and then click the  button.

Fig. 8—Close all open programs and click the Restart button.

TIP� TR lRFDte the GrLYer files LI the\ Dre neeGeG GurLng the LnstDllDtLRn SrRFess� lRRN Ln 
the directory labeled FTDI. 

9. To install driver for LabTrax-8/16, navigate to C:\Program Files\MDAC\
FTDI_2018 and double click on FTDI_2018.exe to launch the FTDI driver installation. 
Follow the instructions for the driver installation.

10. To start the MDAC software, click on the Windows Start button, choose 
Programs>MDAC>MDAC.
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Setting of Latency timer of COM Ports
The COM ports need to be set from 16 ms to 1 ms in the Device Manager of the USB 
serial ports. 

1. Open the Device Manager in the Windows Control Panel. 

Fig. 9—Windows Control Panel

2. Go to Ports (COM & LPTI) and open the drop-down menu. Right click to open the 
SrRSertLes RI the first 8S% serLDl SRrt �e.g. &2M��.

Fig. 10—Open the Ports submenu.

3. Click on Change Settings and then select Tab Port Settings. 

Fig. 11—Choose Change Settings from the popup menu.
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4. Click Advanced. The port settings pop up opens.

Fig. 12—Advanced settings for the COM port.

5. Search the Latency Timer and scroll from the default 16 ms to 1 ms. 

Fig. 13—Change the latency timer.

6. Apply the changes and close the window. You may be prompted to restart your 
computer.

7. Repeat the procedure for the second USB Serial Port (e.g. COM4).

INSTRUMENT SETUP
Setting Up the LabTrax 8/16 Data Acquisition Unit

Analog InputsUSB LED

Front

Power LED USB LEDPower LED Analog InputsAnalog InputsAnalog InputsAnalog InputsAnalog InputsAnalog InputsAnalog InputsAnalog InputsAnalog InputsAnalog InputsUSB LEDUSB LED Analog InputsAnalog InputsAnalog InputsAnalog InputsAnalog InputsAnalog InputsAnalog InputsAnalog InputsAnalog InputsAnalog InputsAnalog InputsAnalog InputsAnalog InputsAnalog Inputs

Fig. 14—The front of the LabTrax 8/16 has eight analog inputs.
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Analog Output Digital Inputs or Outputs USB Port Power Switch

Power Socket

Analog OutputAnalog OutputAnalog Output Digital Inputs or OutputsDigital Inputs or Outputs USB PortDigital Inputs or OutputsDigital Inputs or Outputs USB Port Power Switch

Power Socket

USB Port Power Switch

Power SocketPower Socket

Digital Output

Fig. 15—The back panel of the LabTrax 8/16 has four analog outputs, digital inputs or 
outputs, a USB port, power socket and power switch.

1. Using a standard USB cable, connect the USB port on the back of the LabTrax 
8/16 data acquisition unit to one of the USB ports on the computer.

2. Plug the connector on the end of the LabTrax 8/16 power supply cable into the 
power (PWR) socket on the back of the LabTrax 8/16.

3. Plug the power supply into an AC wall outlet or a power strip with a surge sup-
pressor.

4. When using WPI’s SI-H line muscle test devices do the following connection. Else 
setup your own connection.

5. Connect the Force Output of the SI-BAM21-LCB trDnsGuFer DPSlLfier� the LPF 
Out of the SI-PF100 SrRgrDPPDEle filter PRGule �LI Rne Ls useG� Rr the Corrected 
Output of the SI-AOSUB anti-oscillation module (if one is used) to the IN 1 analog 
input using a BNC-BNC cable.

6. If electrical stimulation of the muscle tissue is required, connect a stimulating 
electrode assembly to the OUT 2 analog output on the back of the LabTrax 8/16. 
OUT 2 functions as a stimulator when it activated by a stimulation protocol.

7. If the muscle tissue will be stretched using a motor, two additional analog inputs 
on the front and another analog output on the back of the Labtrax 8/16 need to 
Ee FRnneFteG tR the PRtRr FRntrRl PRGule Ln the DPSlLfier s\steP�
A. Place a BNC T-adapter on the Position In connector of the SI-MOTDB

Linear Motor Controller that is used with SI-MTM and SI-MKBM muscle 
tester systems, or the Position In connector on the SI-CISB Position Control 
module that is used with SI-CTS Cell Tester systems.

B. Connect a BNC-BNC cable between the OUT 1 analog output of the LabTrax 
8/16 and one of open connectors on the BNC T-adapter attached to the 
Position In connector.

C. Connect another BNC-BNC cable between the IN 2 analog input and the 
remaining open connector on the BNC T-adapter on the Position In connec-
tor. With this connection, the actual signal sent to the motor is recorded.

D. Connect a third BNC-BNC cable between the IN 3 analog input and the Posi-
tion Out connector on either the SI-MOTDB Linear Motor Controller or the 
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SI-CISB Position Control module. With this connection, the actual position 
of the motor is recorded. This signal provides important information on the 
responsiveness of the motor.

8. Turn on the Power switch on the back panel ( I ) of the LabTrax 8/16 unit.

9. Open the MDAC software. When the main window opens (Fig. 16), four channels 
that are capable of displaying the recorded data appear.

CAUTION: MDAC is set on launch with a Zero volt signal to protect your 
eleFtrRnLF GeYLFe. ThereIRre� first sZLtFh Rn /DETrD[� DnG then lDunFh MD$&. 
Now you can switch on your electronic device, with a Zero volt setting.

Fig. 16—The MDAC software main window.

Fig. 17—The MDAC Main Window toolbar has new real-time control functions. 

Progress Indicator                LED Buttons

Fig. 18—The MDAC toolbar has new live Math and Trigger functions.

• LED button color display (green/red) to toggle the live Math or Trigger function 
Rn Rr R΍.
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• The Progress  Indicator shows the progress of repeat protocols.

If a communication error appears:
1. Select Preferences from the Edit pull down

menu (right) on the MDAC main window.
2. In the Preferences window (Fig. 19), set the commu-

nications (VISA COM) port to one of the available ports 
(COMx) on the pull-down window. LabTrax 8/16 will 
present two consecutive numbers (for example, COM3 
and COM4). Always select the lowest number COM port 
(for example, COM3).

Fig. 19—The Preferences window has settings for using MDAC.
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Setting Sampling and Recording Preferences
The sampling and recording parameters of the main window have been set to default 
values that will display data traces that are functional. These parameters can be 
FustRPL]eG tR fit the reTuLrePents RI the e[SerLPentDl SrRFeGure Rr \Rur SreIerenFes.

The Preferences window contains display settings, variables and functions, which are 
used in MDAC:

• Firmware version, serial number, MFG date updated and VISA COM port (HW-OK 
LED) connection between MDAC and LabTrax 8/16 are now set or observed in the 
Preferences window. Visual display of the connected Hardware is given by the 
VISA COM port name and the green HW-OK LED. (If the connection failed or there 
is no connection, the VISA COM port name is disabled and grayed out, and HW-
OK LED is red.) (See Fig. 20.)

Fig. 20—This section of the Preferences window displays the VISA COM port connection 
state. Selecting the appropriate, available VISA COM port updates the state variables.

• <Ru FDn FhDnge the &DlLErDtLRn $ngle DnG sDYeG Lt Ln the MD$& SettLngs file. The 
calibration angle is used during the calibration process to consider the force 
transducer angle of inclination (or any other sensor/transducer), when calibration 
is done on a plane surface (i.e. no inclined transducer support is available). 
Calibration angle compensation uses sine for calculation.

Fig. 21—The initial calibration angle of 70° was used in the Calibration menu.
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NOTE: $ll FDlLErDtLRn YDrLDEles �< sFDle lDEel� MultLSlLer� 2΍set� Dre retrLeYeG DutR-
matically from the Calibration menu and displayed in the Preferences menu or 
the chart axes. Multiplier values are given in Volts/Unit..

1. To customize the sampling and recording parameters, select Preferences from 
the Edit pull down menu on the main window (right). 
The Preferences window opens (Fig. 19).

2. In the Preferences window set these parameters:
For Analog Inputs:
• Y scale label–In the box next to the number 

RI the FhDnnel� enter D ZRrG thDt reȵeFts the 
function being recorded on the channel. For 
example, if contractile force is being recorded 
on the 1st channel (In1), type Force in the Y scale 
label box next to 1st channel. The default settings 
are In1 – In4, for channels 1 to 4.

• Multiplier–Enter the multiplier factor into 
the text box. This is needed to convert the 
recorded voltage into the units of the measured 
parameter. For example, if the calibration of a transducer determines that a 
10g mass creates a 1V signal, place the value 10 (1.000E+1) in the multiplier 
box to change the y-values of amplitudes of the data points by 10X. The Y 
scale label should be altered to include the units, like Force (in g) in this 
example. The default setting is 1.000E+0 or 1.

• Offset–Enter a factor that will be added to or subtracted from the voltages 
recorded on each channel to reposition the trace up or down the Y-axis. The 
default setting is 0 (zero).

• Autoscale–Place a check in the box for each channel to adjust the Y scale 
automatically when voltages go out of range.

• AI sampling frequency–Select a frequency (in Hz) that is appropriate for the 
type of data being recorded. The default setting is 100 Hz.

• Chart’s time scale window–Select the duration (in sec.) of data that will be 
displayed on the main window. The default setting is 30 sec.

For Analog Outputs:
• AO sampling frequency–Select a frequency (in Hz) that is appropriate for 

the time resolution of the stimulus and position protocols that will be used in 
the experiment. The default setting is 1000Hz.

For Data File Path:
• Path to location of data file–Type the path to the location where the data 

files ZLll Ee reFRrGeG Ln the e[SerLPent. ΖI \Ru SreIer� use the Browse ( )
EuttRn Rn the rLght�sLGe RI the SDth ER[ tR seleFt the lRFDtLRn RI the file 
folder. When the Windows Explorer window appears, navigate to the folder 
Zhere \Ru ZDnt tR stRre \Rur files �)Lg. ���. The GeIDult settLng Ls� C:\WPI\
Experiments.tdms.
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Fig. 22—Select the folder in which data files are saved during the experiments. Each TDMS 
file can contain multiple experimental runs.

• Prompt for description at experiment start–Select this check box to 
allow you to enter a brief description of each experimental run and attach 
that notation to the recording. Entering descriptions for each run makes a 
file eDsLer tR lRFDte Zhen Lt Ls neeGeG DgDLn. )Rr e[DPSle� the GesFrLStLRn 
entered in this text box appears in the Open Data File dialog box next to the 
file run nuPEer �)Lg. ���.

Fig. 23—The Open Data File dialog box displays the user-entered description in the 
Description text box.

3. Click OK to activate the changes to the parameter settings.
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Opening Recorded Data File
TR RSen D TDMS run file� seleFt the File menu and choose Open TDMS Run. The 
SrRgress RI file lRDGLng GLsSlD\s Rn sFreen Ds the TDMS file lRDGs. SrRgress RI file lRDGLng GLsSlD\s Rn sFreen Ds the TDMS file lRDGs. 

Fig. 24—The red text indicates that the selected TDMS file is loading.
:hen the file hDs lRDGeG the nDPe RI the lRDGeG TDMS file DSSeDrs Dt the tRS RI the 
window.

Fig. 25—The name of the selected TDMS file appears in the header area (Experiments.tdms).

Deleting Recorded Data Files
�. TR Gelete D GDtD run Ln D TDMS run file� seleFt the File

menu and choose Delete TDMS Run. The Delete TDMS
Run window appears.

Browse to select
the TDMS file.

Select the appropriate
run file.

The red button turns
green.

Press Delete.

Fig. 26—The Delete TDMS Run window displays the run files, and the first one is selected.

�. TR Gelete D TDMS run� ErRZse Dt the tRS tR seleFt the DSSrRSrLDte TDMS file� DnG 
then select the desired data run in the center area of the window where all the 
runs are listed. The selected data run is highlighted and the LED switches from 
red to green indicating that the run is loaded and ready to be deleted. Press the 
Delete button.
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Setting Channel Display Preferences
The display parameters of each channel have been set to 
default values that display data traces that are functional. These 
parameters may be customized for your preferences.

1. To customize the channel display parameters, right click on 
the appropriate channel icon located in the upper right margin 
of the Chart area (Fig. 27). The popup (context sensitive) menu 
(right) opens.

Fig. 27—The Channel icons are located in the top right corner of the 
main window.

2. Set the parameters, as desired.
On each channel, the following parameters can be set:
• Plot Visible–Check to display the recorded data trace on the selected 

channel. If it is not checked, the data channel appears blank.
• Common Plots–Select a plot other than the default smooth curve that is 

normally used for physiological recordings.
• Color–Choose a color for the data trace.
• Line Style–Select another line style for the data trace. The default is a 

continuous line.
• Line Width–Select another line width for the data trace.
• Anti-AliasedȂSeleFt tR DSSl\ Dn DntL�DlLDsLng filter tR the GDtD reFRrGLng. ΖI 

thLs Ls nRt FheFNeG� the GDtD FhDnnel Ls unfiltereG.
• Bar PlotsȂΖI \Ru ZDnt tR GLsSlD\ the GDtD Rn Rne RI fiYe GL΍erent EDr grDShs 

(in either a vertical or horizontal format), select an option here. The default 
setting is a line graph that is normally used for physiological recordings.

• Fill Base LineȂSeleFt hRZ the DreD DERYe Rr EelRZ the GDtD trDFe Ls filleG 
ZLth FRlRr. &hRLFes LnFluGe 1Rne �nR fill�� ]erR� ȂLnfinLt\ DnG LnfinLt\.

• InterpolationȂSeleFt the PethRG useG tR fill the trDFe EetZeen the reFRrGeG 
data points. The default setting for interpolation is a smooth curve, which is 
best for most physiological signals.

• Point Style–Open this menu to select the style of point used to identify real 
data points on the trace.

• X Scale–Highlight X Scale to check the label used on the X-axis.
• Y Scale–Highlight Y Scale to check the labels used on the Y-axis of each 

channel.
• Export–To export the channel’s data, select the destination/ location to 

export. Options available are clipboard, Excel and DIAdem.
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Plot Legend
The data run displayed on the main window can be optimized for viewing and printing 

by using the data display controls . These three controls appear 
on the upper left margin of the data window. For more information, see “Displaying/
Printing Data Files” on page 31.

Setting the Number of Channels
You may select the number of channels you 
need for an application. Options include 4, 6 or 
8 channels for acquisition. The acquired data 
chart on the main window adapts to the 
number of selected channels.

To change the number of channels, select the 
Edit menu (left), choose the Channel Selection
menu item, and then select the number of 
channels from the submenu.

Resetting the Factory Defaults
To reset the factory defaults, select the Edit menu (left) and choose 
Reset Factory. This resets all the factory settings, as follows:

• Y-Label is set to +10V and –10V
• AO Frequency is set to 1000Hz
• AI Sampling Frequency to 100Hz
• Clears the graphs
• 5esets the FDlLErDtLRn PultLSlLer tR � DnG R΍set YDlue 

to 0
• Y scale label to its default label name
• Chart’s time scale window to 30 Sec
• Calibration Angle to 70 Deg

NOTE: Edited protocols are not reset.

Working with Annotations
Using annotations, you may enter notes that will appear on the graphs in the Analysis 
Window. Notes may be entered on the Main window during acquisition or on the 
Analysis window afterwards. 

• Notes entered on the Main window (during acquisition) will display on the Analysis 
window, and they are permanently stored with the data. They can be moved but 
not deleted
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Adding Notes to a Chart During Acquisition
1. To add notes to your chart, enter the note in the Set Annotation fielG Ln the uS-

per right corner of the main window (Fig. 28). 

2. As the data is acquired, press Enter to set the position of the note. Pressing enter 
attaches that note to a particular time during data acquisition.

Fig. 28—Enter the note in the Set Annotation field and press Enter.

3. The annotations display in the Analysis window when you select the Read Anno-
tations checkbox in the upper right corner of the Analysis window (Fig. 29).

Fig. 29—Select the Read Annotations checkbox to display your notes on the graph.

NOTE� $ll DnnRtDtLRns GLsSlD\ Ln the first GLsSlD\eG grDSh� regDrGless RI the FhDnnels.

Repositioning Notes
Notes added during acquisition may not be moved or deleted. They were written to 
the GDtD file Dt sSeFLfiF tLPes� DnG the\ Dre DFtuDll\ DssRFLDteG ZLth thRse GDtD SRLnts.

Fig. 30—When you drag the notes, arrows appear to indicate where the note was moved.

Composing/Editing/Saving Motor Position Protocols 
(OUT 1-3)
The PRtRr useG tR stretFh DnG relD[ PusFle Fells DnG fiEers Ls FRntrRlleG E\ the OUT 1
analog output of the LabTrax 8/16. The amplitudes, 
durations and slopes of the signals that control the 
movements of the motor are programmed using an 
LnterDFtLYe ZLnGRZ DnG sDYeG IRr Iuture use Ln D file 
known as a protocol. 

1. To compose a position protocol, select Edit 
Protocol from the Protocols pull down menu on 
the main window (right). 
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2. The Edit Analog OUT 1 window opens (Fig. 31). Protocols are composed of seg-
ments that are linked together to move the motor according to the requirements 
of an experiment.

Length unit for 
position amplitude

Fig. 31—The Edit Analog OUT 1 window displays in the length units. This window shows 
the first segment added and type of segment, sine wavel, selected. The parameters of the 
segment are set at ±1.5V for 11.00 seconds.

Amplitude for position protocol is programmed in factory length units, e.g. mm. 
The length unLt PD\ Ee user�GefineG. TR Gefine� FlLFN Rn MusFle Ph\sLRlRg\ IrRP 
Toolboxes menu, then click on Motor Settings, which pops up Edit Motor Settings 
window. Then scroll and select the desired unit from OUT 1 Unit menu.

Click on Muscle Physiology/Motor Settings. The Motor Settings pop up dis-
plays for setting the following parameters:

1. OUT1 UNIT – the unit used for editing protocols

2. Out 1 Multiplier – the multiplier calibration factor

�. 28T� 2))S(T Ȃ the R΍set FDlLErDtLRn IDFtRr

4. Set position (OUT 1) as In Channel for display purpose. 
Common is channel 1.

�. Set MRtRr 2΍set Ȃ thLs Ls the SerPDnent PRtRr 2))S(T 
thDt PD\ e[Lst Rr FDn Ee set� GesSLte settLng the 28T� 2΍set YDlue. (.g. Zhen \Rur 
SrRtRFRl LnFluGes Dn 2΍set YDlue Ds stDrtLng SRsLtLRn.

NOTE: Changing the factory calibration unit (OUT1 Unit) needs a corresponding 
change in the Multiplier value (OUT1 Multiplier)!

3. Start building a protocol by selecting the type of ZDYeIRrP neeGeG Ln the first seg-
ment of the protocol. Find the waveform selection box 
in the upper center of the Edit Analog OUT 1 window
Click on either the up or down arrow ( ) to scroll
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 through the list of waveforms available and select the waveform needed in the 
segment. Waveforms include: 
• DC Level • Square Wave (Multiple) • Staircase
• Sine Wave (Single/Multiple) • Ramp (Single/Multiple)

4. Set the parameters of the waveform by entering values into the text boxes to the 
right of each parameter. Depending on the waveform selected, parameters can 
include: 
• Amplitude (V) • Width (sec.) • Quantity (No.)
• Delay (sec.) • Interpulse Distance (sec.) • more...

�. 2nFe the SDrDPeters RI the first segPent hDYe Eeen set� FlLFN Rn the Add button 
to add the segment to the protocol. The list of segments in a protocol is shown 
on the left side of the protocol window (Fig. 31).

6. To add another segment to the protocol, click on the Add button. Select the 
waveform type from the selection box as described in Step 3. Set the param-
eters of the waveform in this segment by entering values for each parameter as 
described in Step 4. This segment will be the next segment on the list.

7. Continue to add the needed segments to the protocol, using the same procedure 
used to add previous segments, until the protocol is completed (Fig. 32).

Fig. 32—It shows a square wave simulation protocol. As seen on the lower window, the 
motor is moved to specific positions at prescribed velocities by programming the voltages 
and duration of each segment.

8. To edit the type and the value of a waveform in a segment, highlight the segment 
on the list of segments. Make the changes to the waveform type and the values of 
the parameters. Click on the Enter key to enter the changes into the protocol.

9. To delete a segment from a protocol, highlight the segment to be deleted from 
the list of segments. Click on the Delete button and the segment will be deleted 
from the protocol.
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10. To insert a segment into the list of segments, highlight the segment above the po-
sition of the new segment. Click on the Insert button to insert the new segment 
into the list. Highlight the newly-inserted segment. Set the waveform type and the 
values of the parameters. Click on the Enter key to enter the changes into the 
protocol.

11. To clear all the segments from the list and build a new protocol, click on the Clear
button.

12. To save a protocol, click on the Save button. You will be directed to the folder 
designated as the storage site. Name the protocol, and click OK.

13. To edit a protocol that has already been saved, click the Open button in Edit 
Analog OUT 1 window. Select the protocol to be altered from the list on the 
folder and click OK. Change the protocol using the tools explained above. Save 
the protocol using the same procedure outlined in Step 12.

14. Click the Load button and select a protocol to make a protocol active. The active 
protocol is the one that MDAC executes. The protocol will not run until it has 
been loaded into the software.

15. You may now use the Repeat / Repeat for utility, where a base protocol can be 
repeated x times or for a given time. This allows for programming only a base 
protocol (e.g. base stimulation burst) and letting the program repeat this base 
protocol to the desired protocol length. 

  
Fig. 33—Repeat protocol selection option.

The mode of repetition may be changed by pressing the Edit button. A pop-up 
window opens where the mode of repetition can be chosen: 
• Repeat x Times or
• Repeat x Seconds. 

Fig. 34—Use the Edit Repeat Protocol window to configure the repeat protocol function.

CAUTION: If position and stimulation protocols are activated during a data 
recording, the recording will stop at the end of the longest active protocol. For 
example, if the position protocol is 20 seconds long and the longer of two 

DFtLYe SrRtRFRls� the reFRrGLng ZLll run IRr �� seFRnGs EeIRre turnLng R΍ DutRPDtLFDll\. 
Make sure all protocols have the proper total durations. If no protocols are active, 
data recording will continue until you click the STOP button.

The same procedure is used for editing analog protocols for channels OUT2 or 
OUT3.
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Editing Channel Math
Click on Channel Math under Edit drop down menu. This pops up Edit Channel 
Math window. The Edit Channel Math pop-up window (Fig. 35) allows you to run 
mathematical operations during online data sampling. Possible mathematical 
operations include adding, subtracting, multiplying or dividing two selected AI 
FhDnnels �Ζn�&hDnnel �� DnG Ζn�&hDnnel ��� DnG GLsSlD\Lng the result Rn D GL΍erent 
selected AI channel (Out-Channel #). The online AI channel derivative is possible on a 
single selected AI channel (In-Channel #1 or In-Channel #2) and displaying the result 
Rn D GL΍erent seleFteG $Ζ FhDnnel �2ut�&hDnnel ��. MultLSle PDthePDtLFDl RSerDtLRns 
are discarded. This is possible only when the selected mathematical operation is 
highlighted and all other operations are disabled (Fig. 36).

NOTE: AI In-Channel# and AI Out-Channel# should be selected in ascending order.

  
Fig. 35—The Edit Channel Math pop-up window shows the main mathematical functions.
Fig. 36—The Select Math Operation area shows the selected addition operation, while all 
other mathematical operations are disabled

Graph Math function can be turned ON/OFF either in the Edit Channel Math pop-up 
window by the Graph Math check box or in the MDAC Main window toolbar using the 
Math LED (green/red is ON/OFF). 
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In addition, you can run an online FFT analysis on single AI channel simultaneously, 
depending on the selected channel number. Channel number selection is considered 
in Select FFT-Channel Ring button.

Fig. 37—The Select FFT-Channel is single selection and pressing FFT button launches the FFT 
window with data sampling.

NOTE: Online FFT analyses can be done simultaneously with mathematical operation. 

Calibrating a Transducer
1. Select Calibration from the Edit menu (Right). The Edit

Calibration window appears (Fig. 38).

Fig. 38—(Left) The Edit Calibration window with main functions. 
Fig. 39—(Right) Calibration units may be selected.

2. Select the AI channel to be calibrated. Switching between the AI channels empties 
the memory of its temporally stored calibration values.

Fig. 40—Choose the AI Channel.

The Select FFT-Channel is single selection and pressing FFT button launches the FFT 

: Online FFT analyses can be done simultaneously with mathematical operation. 

The Select FFT-Channel is single selection and pressing FFT button launches the FFT 

: Online FFT analyses can be done simultaneously with mathematical operation. 
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3. Select the Unit of your calibration value. You can select between g, mg, µg, ng, 
mm, µm, AU (arbitrary unit).

Fig. 41—Select your units of measurement.
4. Press the Unit Conversion button to use N, mN, µN or nN unit for force and g, 

mg, ug or ng unit for mass to obtain the conversion factor that is taken into con-
sideration during the calibration process.

5. Enter the Unit Value, which is the value to be calibrated for the chosen unit.

Fig. 42—Select the value to be calibrated.

6. Clear the calibration values from the memory by pressing the Undo button. You 
Dre SrRPSteG tR seleFt Zhether tR FleDr the ZhRle Eu΍er RI the FDlLErDtLRn YDlues 
or the last calibrated value.

7. When the calibration is in equilibrium, run the calibration, by pressing the Start 
calibration button. This acquires the voltage value for the chosen unit value. 

�. 5eSeDt the FDlLErDtLRn IRr GL΍erent unLt YDlues. The FRrresSRnGLng YRltDge Ls 
displayed in the Indicator graph as Measured Voltage. For each calibration the 
last 100 sampled points of the measurements at 128 samples/second are taken 
into consideration. When the calibration weight has stabilized, run the calibration 
measurement for at least 1–2 seconds.

9. To obtain the calibration factors, press the Regression Fit button. For the regres-
sLRn fit� \Ru neeG Dt leDst tZR FDlLErDtLRn SRLnts. The lLneDr regressLRn fit tDNes 
LntR DFFRunt SRssLEle R΍set YDlues RI the trDnsGuFer. $ Rne SRLnt FDlLErDtLRn Ls 
DlsR SRssLEle. The FDlLErDtLRn YDlues DnG the regressLRn fit lLne Dre GLsSlD\eG Ln 
the graph, as well as the R2 FReɝFLent� LnGLFDtLng the DFFurDF\ RI the FDlLErDtLRn. 
Calibration factors are calculated by using the linear equation y = mx+b of the 
calibration values.

TIP: When you close the panel, MDAC takes the new calibration into consideration. 
Select Preferences from the Edit menu, and notice the y-axis label. If desired, you may 
customize the y-axis label.

10. Press the Apply button to save the calibration or press the X in the upper right 
corner to close the window without saving the new calibration information.

The Calibration menu includes the possibility to consider the angle inclination of a 
force transducer (or any sensor) when no force inclination stand is available.

Data measuring is done and obtained on raw values (i.e. display of the measured 
YRltDge ZLthRut Dngle FRrreFtLRn� ZhLle the regressLRn fit trDnsIRrPs the trDnsGuFer 
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FDlLErDtLRn YDlues tR the FRrresSRnGLng MultLSlLer �9Rlts�8nLt� DnG 2΍set �9Rlts� YDlues� 
considering the possible angle compensation. These values are displayed in the Volts - 
In-channel relationship.

Angle compensation can be turned ON/OFF by switching the toggle button
.Calibration values can be exported to Excel spreadsheet by pressing the Export 
button. (Data export includes the measured calibration values (compensated) and the 
GDtD SRLnts useG IRr the regressLRn fit�

Calibration values, i.e. Multiplier of a desired sensor, are obtained by linear regression 
of the Calibration unit – Volts relationship to obtain a Unit/Volts calibration value. 
This value is automatically considered during data acquisition and displayed in the 
Preferences dialog.

• Display of calibrated Multiplier value in Unit/Volts.
• DLsSlD\ RI FDlLErDteG 2΍set YDlue Ln 9Rlts.
• DLsSlD\ RI 5 sTuDre FReɝFLent tR LnGLFDte gRRGness RI fit �Ln Edit Calibration

window)

Ζt Ls DlsR SRssLEle tR LnFluGe user�GefineG FDlLErDtLRn unLts IRr DGGLtLRnDl sensRrs 
by selecting Other. The neZ user�GefineG FDlLErDtLRn unLt DnG Lts FRrresSRnGLng 
FDlLErDtLRn YDlues �MultLSlLer Ln 8nLt�9Rlts DnG 2΍set Ln 9Rlts� Dre SerPDnentl\ stRreG 
and displayed in the Preferences dialog.

Unit Conversion
The Unit Conversion menu may be used to convert mass into force units. 
1. Choose the Edit menu and select Unit Conversion. The Edit Unit Conversion 

window appears (Fig. 43).

Fig. 43—Edit Unit Conversion window is used to convert mass into force units.
2. Select your AI channel and the Mass Unit to be converted into Force Unit. Once 

the Unit conversion is complete, the corresponding AI channel is grayed out and 
cannot be longer converted. The Conversion Factor and the Channel unit dis-
played are taken into consideration in Preferences window and the y-axis label of 
the corresponding chart. 
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NOTE� The FRnYersLRn IDFtRr Ls tDNen LntR DFFRunt ZLth the MultLSlLer DnG 2΍set 
value shown on the Preferences window for the selected channel. For further 
conversion, use Preferences window.

Setting Record Time
For setting record time, click on Record Time from Edit drop down menu. This pops 
up Edit Record Time window.

The Edit Record Time pop-up window allows you to set a determined sample time 
during Free Run modus (no protocol active). Set parameters are the Record Time and 
the Time Unit (seconds, minutes or hours). 

Fig. 44—Set Record Time pop-up window allows you to set a determined sampling time in 
the Free Run modus.

Editing Threshold Trigger
The Threshold Trigger under Edit menu allows online triggering of AI channels:

• For using the trigger function, select the trigger reference AI channel (In-channel 
#1) that corresponds to the reference signal of the Absolute Threshold trigger 
value, which in turn triggers the corresponding AI channel (In-Channel #2). Values 
below the trigger threshold value are cut and set to zero for the channel to be 
triggered.

• Display In-Ch#1 check box allows for triggering and displaying In-Ch #1 as its own 
reference and triggered signal on AI channel In-Channel #2.

• AI Trigger can be turned ON/OFF in Edit Threshold Trigger or by using the 
Trigger LED (ON/OFF is green/red) in MDAC Main Window.
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Fig. 45—The Edit Threshold Trigger pop-up window.

• Trigger operations are saved in user-settings and loaded on opening MDAC.

Online Filtering
A new function that has been included in MDAC - LabTrax-8/16 is the use of an online 
sRItZDre filter �%utterZRrth Ȃ /RZSDss� +LghSDss� %DnGSDss Rr %DnGstRS� GurLng GDtD 
acquisition for Analog Input signals (AI channels).

�. Press �)�! tR RSen the $Ζ &hDnnel filter settLngs GLDlRg ZLnGRZ DnG IRr RnlLne 
filterLng IRllRZLngs FDn Ee seleFteG�
• DesLreG FhDnnel tR filter.
• Filter parameters.
• &hRLFe tR DFtLYDte the filter �)Llter 21 Ȃ )Llter 2))� IRr the GesLreG FhDnnel. 
• SDYe Dll filter SDrDPeters eDFh tLPe D FhDnnel hDs Eeen FRnfigureG IRr 

filterLng� IRr Iuture use.

NOTE� 2nlLne GLgLtDl filterLng Ls GRne DIter FhDnnel PDth IunFtLRns� DllRZLng IRr RnlLne 
filterLng RI GerLYDtLYe sLgnDls. SLPLlDr IRr trLgger IunFtLRns.

Fig. 46—The AI Channel filter pop-up window shows the settings dialog window for online 
filtering.
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Toolboxes

The Muscle Physiology Toolbox is used to set Motor calibration values that are 
considered for protocol programming, i.e. use of length units for displacement 
protocols.

Fig. 47—<Edit Motor Settings> main window

Programmable variables are:
• OUT1 Unit as Volts, cm, mm, nm
• OUT1 Multiplier value in Volts/Units corresponds to the Motor Multiplier 

calibration value and allows for programming position protocols in length units. 
• 28T� 2΍set Ln 9Rlts FRrresSRnGs tR the MRtRr 2΍set FDlLErDtLRn YDlue DnG 

allows for programming position protocols in length units. 
• MRtRr 2΍set �9Rlts� DYRLGs SeDN SerturEDtLRn GurLng SRsLtLRn SrRtRFRl.
• Position (OUT 1) as In channel sets the AI channel for sampling the real 

Motor response to a programmed position protocol (Observe to connect 
the Position Out BNC connection of Motor Control Unit to the selected AI 
channel of the LabTrax 8/16 board).

OPERATING INSTRUCTIONS
Data Recording
Once the preferences and parameters of the LabTrax 8/16 data acquisition system 
are programmed and after the position, stimulation or digital output protocols are 
loaded, data recording can begin.

A. Selecting a Position Protocol (Analog OUT 1)
1. Select the position protocol, if any, to be used 

during the recording. Select Load Position 
Protocol from the Protocols pull down menu 
(right).
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Fig. 48—Choose the location where the protocol is located and press OK.
2. On the next window (Fig. 48), navigate to the appropriate directory and select the posi-

tion protocol needed in the experiment. Click OK to activate the selected protocol.
�. 2n the uSSer PDrgLn RI the PDLn ZLnGRZ �)Lg. ���� finG the Position (OUT1) text box. 

The value to its right below the graph is the total duration of the selected position 
protocol.

NOTE� ΖI the GurDtLRn RI the SRsLtLRn SrRtRFRl Ls shRrter thDn Rther SrRtRFRls� the finDl SRsL-
tLRn RutSut RI the SRsLtLRn SrRtRFRl rePDLn Ln e΍eFt untLl the lDst SrRtRFRl FRPSletes.

Fig. 49—The Position Output checkbox is in the upper left corner of the main window.
4. Select the check box left of the Position Output text box to mark the data recording.

B. Selecting a Stimulation Protocol (Analog OUT 2)
 1. Select the stimulation protocol, if any, to be

used during the recording. Select Load 
Stimulation Protocol from the Protocols
pull down menu (right). The Choose or Enter 
Path of File window appears (Fig. 48).

2. Select the stimulation protocol needed in the 
experiment. Click OK to activate the selected protocol.

�. 2n the uSSer PDrgLn RI the PDLn ZLnGRZ� finG the Stimulation (OUT2) text box. The 
value to the right below the graph is the total duration of the selected stimulation 
protocol.

NOTE: If the duration of the stimulation protocol is shorter than the other proto-
cols, the output is set to 0.0V when the protocol completes.

Fig. 50—The Stimulation Output checkbox is located to the right of the Position Output field.
4. Select the check box to the left of the Stimulation Output text box to mark the 

data recording.
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C. Selecting Analog Output Protocols (Analog OUT 3)
1. Load any analog output protocols that are 

needed duringthe recording. Select Load 
Out 3 from Load Protocol under Protocols
pull down menu (right). The Choose or Enter 
Path of File window appears (Fig. 48).

2. Select the digital output protocol needed in 
the experiment. Click OK to activate the selected protocol.

�. 2n the uSSer PDrgLn RI the PDLn ZLnGRZ� finG the OUT # text box . 
NOTE: If the duration of the analog output 3 protocol is shorter than the other 
protocols, the output is set to 0.0V when the protocol completes.

Fig. 51—Analog Output fields are located next to the Stimulation Output field.
4. Select the check box to the left of the OUT3 text box to mark the data recording 

with lines that indicate the transition points between segments of this protocol 
(Fig. 52).

D. Setting up Continuous Stimulation
A continuous stimulation protocol allows you to 
run a predetermined stimulation protocol 
LnGefinLtel\. 
1. From the Protocols pull down menu (right), 

select Continuous Stimulation then click
Edit Continuous to edit a stimulation pro-
tocol. The Edit Continuous Stimulation
window opens (Fig. 52).

Fig. 52—The Edit Continuous Stimulation window allows you to change the frequency of the 
continuous stimulation protocol.

2. Select the desired analog output channel from the AO channel list box. Options 
include OUT1, OUT2 or OUT3.

3. In the Stimulation Frequency fielG� set the IreTuenF\ Ln +ert] thDt ZLll Ee useG 
for continuous stimulation. The default value is 1Hz.
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4. In the Pulse Width fielG� set the Sulse ZLGth. The GeIDult Ls � Ps. 
5. Determine how you want to start and stop continuous stimulation:

• If you would like for the software to turn the continuous stimulation on after 
eDFh run DnG turn Lt R΍ EeIRre eDFh run� then seleFt the OFF/ON Operate 
automatically checkbox.

• Or, you can manually start and stop the continuous stimulation. From the 
Protocols drop down menu, select Continuous Stimulation. Then, choose 
Start or Stop from the submenu.

• It is possible to select all three AO channels to be used for continuous 
stimulation protocol, as a pacing function. Continuous Stimulation does not 
allow for data sampling. 

When continuous stimulation is running, the Stimulation LED (located on the 
right side of the header area of the window) turns green. When there is no con-
tinuous stimulation, the Stimulation LED is red (Fig. 53). Simulation LED turns red 
during recording time.

Fig. 53—The Stimulation LED turns red when no stimulation is taking place.

TIP:  The four continuous stimulation channels may be activated and deactivated by 
pressing the Stimulation LED.

E. Recording Data
1. When you are ready to conduct an experiment, click the Record (F10) button on 

the upper left side of the main window. As soon as you click the button, it immedi-
ately toggles to a Stop button.

2. If a data run is still displayed on the main chart window, a dialog box appears as a 
reminder. To overwrite the data displayed on the main window, click OK.

NOTE� $ll SreYLRusl\ reFRrGeG GDtD runs Dre DutRPDtLFDll\ sDYeG Ln D GDtD file LI the 
data path was programmed on the Preferences window.

�. $nRther GLDlRg ZLnGRZ DSSeDrs Ds the first FlRses. ΖI neeGeG� t\Se D shRrt GesFrLS-
tion of the event being recorded on this data run to distinguish it from the other 
GDtD runs Ln the GDtD file. &lLFN OK to close the dialog box, and the recording will 
begin in a few moments.
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4. If position and/or stimulation protocols are activated, the recording stops at the 
end of the longest active protocol. For example, if the position protocol is 20 
seconds long, and it is longer than the stimulation (or digital output) protocol, the 
recording will run for 20 seconds.

NOTE: If no protocols are active, data recording continues until you click the STOP button.
5. At any time, the recording can be halted by clicking the STOP button.
6. Continue recording runs until the experiment is complete.

Displaying/Printing Data Files
The data run displayed on the main window can be optimized for viewing and printing 

by using the data display controls . These three controls appear on 
the upper left margin of the data window.
• To reposition the data on a channel, click the  button. This turns the 

normal cursor into a hand cursor. Place the hand cursor on the channel to be 
repositioned. Click and drag the hand to reposition the data on the selected 
channel. The other channels will move horizontally to synchronize the time bases 
on all channels, but they will not move vertically.

• To expand or compress the data displayed, use one of six functions on the Zoom
menu.

Fig. 54—Click the Zoom button to see the six expansion/compression functions on the 
Zoom menu.

Click on the Loop button in the array to open this menu (Fig. 54). Select the 
required function by clicking the symbol of the function. The selected function is 
highlighted by a blue box. Available functions include:
• Zoom In–Select the top left icon . The menu disappears when the icon is 

selected. On the data channel to be expanded, place the cursor above and to 
the left of the data to be expanded. Click and hold the left mouse button as 
you drag the cursor over the data area to be expanded. The selected area 
ZLll e[SDnG tR fill thDt FhDnnel GLsSlD\. The tLPe EDse RI the Rther FhDnnels 
also expands.

• Horizontal Expansion–Select the top center icon . On the data channel 
to be expanded, place the cursor to the left of the data to be expanded. Click 
and hold the left mouse button as you drag the cursor to the right and over 
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the data area to be expanded. The selected area will expand horizontally to 
fill thDt FhDnnel GLsSlD\. The tLPe EDse RI the Rther FhDnnels DlsR e[SDnGs.

• Vertical Expansion–Select the top right icon . On the data channel to be 
expanded, place the cursor above the data to be expanded. Click and hold 
the left mouse button as you drag the cursor down and over the data area to 
Ee e[SDnGeG. The seleFteG DreD e[SDnGs YertLFDll\ tR fill thDt FhDnnel GLsSlD\.

• Zoom to Extent–Select the bottom left icon . All the data in the run is 
FRPSresseG Rr e[SDnGeG sR thDt the ZhRle run fits Rn D sLngle ZLnGRZ.

• Step Expansion–Select the bottom center icon . Place the cursor 
anywhere on any of the data channels. Click the left mouse button and the 
trace on each channel expands.

• Step Compression–Select the bottom right icon . Place the cursor 
anywhere on any of the data channels. Click the left mouse button and the 
trace on each channel compresses.

Main Window Context Menu
Context-sensitive menu available on the main window 
(right). To open the menu, right-click on the Acquired Data 
window.
Export submenu can be used to export data.
• Use this submenu to select the method needed to 

export the data points in the data run. Data can be 
exported to: 
• Clipboard • Microsoft Excel
• DΖ$GeP ȏ SLPSlLfieG LPDge.
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Analyzing Data
)rRP the $nDl\sLs ZLnGRZ� \Ru hDYe the RSSRrtunLt\ tR DSSl\ D YDrLet\ RI filters� 
mathematical calculations and statistical comparisons to your data. 

Menu Bar
Active Channel
Check Boxes

Annotations Check Box

Path Text Box
Path LED Center Cursor Button

Refresh Button

Quick Access 

Chart Area

Graph 
Controls

Fig. 55—The Analysis Window graphically displays data from a selected TDMS data file.

Menu Bar–Access all the pull down menus for the Analysis window

Active Channel Check boxes– A number of check boxes are arranged in the upper 
left corner of the window. These check boxes indicate which channels are active in the 
RSen GDtD file.

Annotations Check box–Select this check box to display any notes that have been 
entered.

Path te[t fielG shRZs the SDth RI the GDtD file \Ru seleFteG. The Path LED next to it 
turns IrRP reG Zhen the file Ls lRDGLng tR green Zhen the file Ls reDG\ IRr use. 

 –The Refresh button is used to update the display. For example, if you use 
more than one screen (monitor) on your PC, Refresh may be used to update the 
display. 

Monitor Field–This Ls D reDG Rnl\ fielG. ΖI \Ru Dre usLng PRre thDn Rne PRnLtRr sFreen 
with your computer, you may drag the Analysis window to a secondary monitor and 
resize it as desired. Then, press Refresh to update your display. The monitor which is 
DFtuDll\ useG GLsSlD\s Ln thLs fielG� DnG the Analysis window dynamically adapts to the 
new monitor/window size.

Press the Center button to center the cursor for each channel in the Chart Area.



34 World Precision Instruments

Chart Area–The data for each channel displays in this area, along with a control 
legend for each channel.

Graph Controls–:hen tZR FursRrs Dre useG IRr D sLngle FhDnnel� the tLPe GL΍erenFe 
EetZeen the FursRrs Ln thDt FhDnnel DSSeDrs Ln the fielG lDEeleG T2–T1, and the value 
GL΍erenFe Ls GLsSlD\eG Ln the fielG lDEeleG V2–V1. Data Display Controls are also 
available for each channel. See “Displaying/Printing Data Files” on page 31.
Time Difference Value Difference

Data Display Controls

Fig. 56—The graph controls.

Fig. 57—The Description displays the file description above the first selected channel.

Fig. 58—The Refresh button, refreshes all data and axes changes like re-open the data file.

Fig. 59—The Quick Access menu allows for direct graph/signal processing using pre-defined 
parameters or formerly set parameters of the selected function.

Quick Access allows for direct access to a limited number of functions, which are 
applied directly either to all graphs/channels or single selected graph/channels, 
depending on the Time Scale selection and active channel.
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Fig. 60—The Quick-Access pull-down menu selection.

Working with Data on the Graphs
$Iter \Ru RSen D GDtD file Ln the $nDl\sLs
 window, you have options for working with 
the file usLng IunFtLRns ZhLFh PD\ Ee IRunG 
in the context sensitive menu. Display the 
graph pop-up menu (left) by right clicking in 
the chart area of the graph you want to work 
with.

NOTE: Most of the functions of this menu 
are activated/can be used only when MDAC 
main window is closed.

Visible Items–From this submenu (right), 
you may select the 
legends and labels to be displayed on the 
Analysis window. Items that may be displayed include:

• Plot Legend • Scale Legend
• Graph Palette • Cursor Legend
• X Scrollbar • X Scale
• Y Scale • Unit Label

Clear Graph–Use this menu item removes the selected graph 
from the display. Cleared items are not deleted. To reload the data, 
restore the defaults. See “Restoring Defaults” on page 47.
Create Annotation–Use this menu item to set marks on the graph. 
$nnRtDtLRns Dre DutRPDtLFDll\ sDYeG ZLth the GDtD file.
Delete All Annotations–Selecting this menu item deletes all 
annotations that you have added to the graph. 
AutoScale XȂSeleFtLng thLs RStLRn sFDles the ;�D[Ls sR thDt Dll GDtD SRLnts fit Rn the 
same display window.
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AutoScale Y– Selecting this option automatically adjusts the Y scale when values go 
out of range. 
Smooth UpdatesȂSeleFt thLs Penu RStLRn tR rePRYe PLnRr ȵuFtuDtLRns IrRP the 
display of the graph.
Export–From this submenu, you have several options to export your data. See 
“Exporting Data from a Single Graph” on page 36.

Exporting Data from a Single Graph
1. To export data from a single channel, right click on a graph in the chart area (of 

the Analysis window) to display the popup menu (above). 

2. Select the Export submenu and choose one of the export options:
• Export Data to Clipboard–The graph data is copied to the clipboard and 

PD\ Ee SDsteG LntR D te[t Rr sSreDGsheet file.
• Export Data to ExcelȂThe file RSens Ln MLFrRsRIt Excel with a generic name. 

If desired, you may select Save from the Excel File Penu tR sDYe the file.
• Export Data to DIAdemȂThe file Ls e[SRrteG Ln D IRrPDt thDt PD\ Ee RSeneG 

by National Instruments DIAdem program.
• Export Simplified Image–An image of the graph (in bitmap, EPS or EMF 

IRrPDt� PD\ FDStureG Rn the FlLSERDrG Rr sDYeG tR D file. See ȊSDYLng Dn 
Image of a Graph” on page 36.

Saving an Image of a Graph
1. Right click on a graph in the chart area (of the Analysis window) to display the 

popup menu. Select the Export submenu and choose Export Simplified Image. 
The Export Simplified Image window appears (Fig. 61).

Fig. 61—The Export Simplified Image file lets you determine how the image exports.

�. SeleFt the t\Se RI LPDge file tR e[SRrt �%LtPDS� (nFDSsulDteG PRstsFrLSt Rr (n-
hDnFeG MetDfile�.

3. Select Export to clipboard or Save to file. If you select Save to file, enter the 
GLreFtRr\ SDth Zhere \Ru ZDnt tR sDYe the file Ln the te[t fielG Rr FlLFN Rn the 
EuttRn tR seleFt D file lRFDtLRn.

4. Click Export.
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Saving a Processed File in a Binary Format
:hen \Ru finLsh SrRFessLng D file� \Ru PD\ sDYe Lt Ln D binary format. Select the File
menu (in Analysis window) and choose Save Binary File. The file ZLll Ee sDYeG Ln the 
sDPe lRFDtLRn DnG ZLth the sDPe nDPe Ds the RSen GDtD file. The file Ls sDYeG ZLth D 
.FLT extension

Opening a Data File for Analysis
1. To analyze collected data, select Analysis from the main menu. This opens 

Analysis window.

NOTE: If the Analysis window is already open, you may:
• 2Sen D GL΍erent GDtD file E\ seleFtLng File>Open TDMS File.
• 2Sen D ELnDr\ GDtD file E\ seleFtLng File>Open Binary File.
• 2Sen D te[t GDtD file E\ seleFtLRn File>Open Text File.

Fig. 62—The Open TDMS Run window allows you to select a file for analysis.

2. The main section of the window displays the data runs saved in that folder (Fig. 
62). To open another folder location, click on the Browse button  to the right 
of the TDMS file text box. On the next window, browse the computer to locate 
and highlight the required folder. Click the OK button to open it.

�. &lLFN Rn D file tR hLghlLght Lt. ΖI the file Ls nRt reDG\ tR Ee RSeneG IRr DnDl\sLs� the 
Open OK /(D turns reG. ΖI the file Ls reDG\ tR RSen� the Open OK LED turns 
green. 
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4. Press Open button. The Analysis window displays the original data set and the 
data from all the recorded channels are displayed. 

TIP� ΖI \Ru GR nRt ZLsh tR see the GDtD IrRP Dll the FhDnnels Ln the GDtD file� \Ru 
may un-select the Active Channel Check boxes of the channels you do not wish 
to analyze.

Changing the Display of a Data File
The RStLRns DYDLlDEle IRr FhDngLng the GLsSlD\ RI D GDtD file FDn Ee IRunG Ln the Edit
menu (of the Analysis window).

• ”Changing the Time Scale” on page 38.
• “Hiding Calculations” on page 39.
• “Using a Single or Double Cursor” on page 39.

Changing the Time Scale
 1. To change the time scale of the displayed channels, click on 

the Edit menu (of the Analysis window) and select Edit Time 
Scale. The Select Time Scale window appears.

Fig. 63—Select the Time Scale unit and check box to switch Single Time 
Scale ON/OFF.

2. Use the arrow keys to select the time scale. Options include 
Hours, Minutes and Seconds.

3. This menu allows for selecting either Single Time Scale ON to 
use all cursors simultaneously or Single Time Scale OFF to use 
a given cursor for one single active graph/channel.

In Single Time Scale OFF mode, the active graph/channel is 
highlighted by the red Channel Name (e.g. Channel 1 Active). Place the cursor of 
the desired channel to a ctivate a channel/graph. This is only used when you are 
moving the cursor on the selected active channel/graph. It may also be used in 
Quick Access to realize data/signal processing directly on only the active channel. 

Fig. 64—The channel name indicator switches to Channel 1 Active (red display), when Single 
Time Scale is set to OFF. 

4. Click Close
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Hiding Calculations
To hide the calculation windows, click on the Edit menu (of the Analysis window) and 

select Hide Calculation. To reveal the calculation windows again, press .

Using a Single or Double Cursor
To display a single cursor in each graph, click on the Edit menu (of the Analysis
window) and select Single Cursor.

To display two cursors on each graph, click on the Edit menu (of the Analysis window) 
and select Double Cursor. The reG FursRr Ls the first FursRr. Ζt hDs the FRRrGLnDtes 
�T�� 9��� Zhere T� Ls the first tLPe DnG 9� Ls the first YDlue. The seFRnG FursRr Ls Elue 
with coordinates (T2, V2).

Info Data shRZs the file GesFrLStLRn Must DERYe the first seleFteG FhDnnel. &Dn Ee 
turneG�Rn E\ first seleFtLRn DnG turneG�R΍ E\ seFRnG seleFtLRn.

Applying a Butterworth Filter
The %utterZRrth filter Ls Dn FIR (finLte LPSulse resSRnse� filter ZhLFh FDn Ee useG Ds D 
lRZ SDss filter� D hLgh SDss filter� D EDnG SDss filter Rr D EDnG stRS filter. 

Fig. 65—The Butterworth Coefficient window lets you set the parameters of your filter.
�. TR DSSl\ D %utterZRrth filter� FlLFN Rn the Filter menu (of the Analysis window) and 

select Butterworth. The Butterworth Coefficients window appears (Fig. 65).
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2. Use the arrows next to the Select Channel fielG tR seleFt D sLngle FhDnnel Rr Dll 
channels. By setting up Multiple Selection ON� \Ru FDn filter Ds PDn\ FhDnnels 
or combination of channels that you like.

3. Use the arrows next to the Filter Type fielG tR seleFt D filter. 2StLRns LnFluGe /RZ 
Pass Filter, High Pass Filter, Band Pass Filter and Band Stop Filter.

4. Use the arrows next to the Cutoff fielGs tR DSSl\ the DSSrRSrLDte FutR΍ IreTuen-
FLes. 2StLRns DYDLlDEle GeSenG uSRn the t\Se RI filter seleFteG.

5. Use the arrows next to the Filter Order fielGs tR set the filter RrGer. The hLgher 
the filter RrGer the steeSer the resSRnse rRll R΍.

7. Click Close button

Filter or Channel math e΍eFt RI seleFteG SDrDPeters Ls GLsSlD\eG GLreFtl\ 
Ln MD$& $nDl\sLs :LnGRZ tR gLYe D SreYLeZ RI the e΍eFt RI the seleFteG 
FRnfigurDtLRn. 8se the SeleFt RStLRn Ln Select Channel rLng Penu tR unGR filter Rr 
FhDnnel PDth FRnfigurDtLRnȇs GLreFt e΍eFt Rn GDtD�sLgnDls. ThLs filter FRnfigurDtLRn 
functioning is like all data/signal processing methods.

Fig. 66—The Butterworth filter configuration effect and preview on direct processed data/
signals in MDAC Analysis Window.

NOTE: Data/signal processing is done on the entire data set of the selected channel, 
while only the processed signal of the formerly selected time range is displayed.
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Applying a Savitzky-Golay Filter
The SDYLt]N\�*RlD\ filter Ls D SRl\nRPLDl filter. 

�. TR DSSl\ D SDYLt]N\�*RlD\ filter� FlLFN Rn the Filter menu (of the Analysis window) and 
select Savitzky-Golay. The Savitzky-Golay Coefficients window appears (Fig. 67).

Fig. 67—The Savitzky-Golay Coefficient window lets you establish the parameters of your filter.

2. Use the arrows next to the Select Channel fielG tR seleFt D sLngle FhDnnel Rr Dll 
channels. By setting up Multiple Selection ON� \Ru FDn filter Ds PDn\ FhDnnels 
or combination of channels that you like.

3. Use the arrows next to the Polynomial Order fielG tR estDElLsh the RrGer thDt Ls 
applied.

4. Use the arrows next to the Side Points fielG tR set the nuPEer sLGe SRLnts tR Ee 
filtereG.

6. Click Close button
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Applying a Moving Average Filter
The PRYLng DYerDge filter FDlFulDte the PeDn YDlue RYer D set SerLRG RI tLPe �DYerDgLng 
length) for each sampled data point. No data points are missing in the sampled data. This 
filter Ls e΍eFtLYe IRr sPDll GDtD sets� Eut neeG FDlFulDtLRn tLPes IRr lDrger GDtD sets.

�. TR DSSl\ D PRYLng DYerDge filter� FlLFN Rn the Filter menu (of the Analysis window) 
and select Moving Average. The Moving Average Coefficients window appears 
(Fig. 68).

Fig. 68—The Moving Average Filter Coefficient window lets you establish the parameters of 
your filter.

2. Use the arrows next to the Select Channel fielG tR seleFt D sLngle FhDnnel Rr Dll 
channels. By setting up Multiple Selection ON� \Ru FDn filter Ds PDn\ FhDnnels 
or combination of channels that you like.

3. Use the arrows next to the Averaging Length fielG tR estDElLsh the nuPEer RI 
data points for averaging. In the sample (Fig. 68), two data points are averaged.

4. Click Close button
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Down Sampling Data
You can down sample data. Down sampled data becomes the 
default data that is used for any other analysis. If you need to restore the original data 
see “Restoring Defaults” on page 47.

�. TR GRZn sDPSle the GDtD tR D sSeFLfiF sDPSle IreTuenF\� FlLFN Rn the Filter menu 
(of the Analysis window) and select Downsample Data. The Sample Coefficients
window appears (Fig. 69). 

Fig. 69—The Sample Coefficients window lets you establish the parameters of your filter.
2. Click Close button

Removing Filters
When necessary, you may reset the graphs and the cursors to their original portions 
and undo any resampling. 
1. Click on the Filter menu (of the Analysis window) and select Default. The Default 

Signals window appears (Fig. 70).

Fig. 70—The Default Signals window lets you return to your original data display.
2. Use the arrows next to the Select Channel fielG tR seleFt D sLngle FhDnnel Rr Dll 

channels. By selecting Multiple Selection checkbox ON, you can restore the data 
display of the channels that you like.

3. Click Close button
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Running Mathematical Operations on Data
You may run mathematical analyses on the data. Options include:

• “Calculating Derivatives” on page 44.
• “Calculating Integrals” on page 45.
• “Calculating Slopes” on page 46.
• “Calculating Latency” on page 46.
• “Restoring Defaults” on page 47.

Calculating Derivatives
You have four options when calculating the derivatives of the data: Signal, Maximum 
Value, Minimum Value and Cursor Value.
1. To calculate a derivative of data on a selected graph, click on the Channel Math

menu (of the Analysis window) and select Derivative. Then, choose:
• Signal to calculate the derivative of the signal. The derivative displays as a 

line on the graph. 
• Max Value to calculate the derivative of the maximum value. The Max 

Derivative window appears (Fig. 71). 
• Min Value to calculate the derivative of the minimum value The Min 

Derivative window appears (Fig. 73).
• Cursor Value to calculate the derivative of the value where the cursor is 

located. The Cursor Derivative window appears (Fig. 74). 

Fig. 71—(Left) Set the parameters for getting the derivative of the signal.
Fig. 72—(Center Left) Set the parameters for getting the derivative of the maximum value.
Fig. 73—(Center Right) Set the parameters for getting the derivative of the minimum value.
Fig. 74—(Right) Set the parameters for getting the derivative of the value of the point where 
the cursor is positioned.

2. Use the arrows next to the Select Channel fielG tR seleFt the GesLreG FhDnnel.
3. If you want derivative of multiple channels. Set Multiple Selection checkbox ON
4. In case of max, min and cursor derivative, the derivative value is seen in its re-

spective derivative window (except for All option).
5. Press Close to close the window.
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Calculating Integrals
1. To calculate a integral of a selected graph, click on the Channel Math menu (of 

the Analysis window) and select Integral. The Signal Integral window appears.

Fig. 75—The Signal Integral window lets you choose the channel to integrate.
2. Use the arrows next to the Select Channel fielG tR seleFt the GesLreG FhDnnel.
3. When the Default Data FheFNER[ Ls seleFteG� the filter Ls DSSlLeG tR the RrLgLnDl 

GDtD set. 8nseleFt the FheFNER[ tR DSSl\ the filter tR the SrRFesseG GDtD.
4. When the Remove Offset FheFNER[ Ls seleFteG� the sLgnDl R΍set Ls rePRYeG tR 

avoid possible drift. This is the default setting. You do not need to change it when 
drift should be avoided. 
+RZeYer� LI \Ru ZDnt tR use the unSrRFesseG GDtD ZLth Lts R΍set� unseleFt the 
checkbox. This may be necessary when a derivative is used or when you are inte-
grating a signal. For example, when a DC or ramp signal needs to be integrated to 
obtain the mathematical corresponding signal like a slope or square signal, you 
ZDnt tR LnFluGe the R΍set. 

5. Press Close The integral of the selected channel displays in the chart area of the 
graph.

Fig. 76—The integral displays on the chart area.
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Calculating Slopes
This option may be used when you are operating with double cursors. It is used to 
calculate the slope value between the two cursor values. The coordinates of the red 
cursor are (T1, V1) and the coordinates of the blue cursor are (T2, V2). So, the slope is 
calculated using the formula:

Slope = (V2–V1)/(T2–T1)
1. To calculate the slope value between two cursor values on a selected graph, posi-

tion your cursors as desired. Then, press Close. Then, click on the Graph Math
menu (of the Analysis window) and select Slope. The Slope window appears (Fig. 
77).

Fig. 77—The Slope Value window allows you to calculate the slope between two points on a 
selected channel.
2. Use the arrows next to the Select Channel fielG tR seleFt the GesLreG FhDnnel.
3. You may set Multiple Selection checkbox ON to get slop of multiple channels.
4. Slope is displayed in Edit Slope window (but not in the case when All channel is 

selected). Slop is also available in the right top of all the corresponding channels.
5. Press Close to close the window.

Calculating Latency
Using the latency option, you can calculate the latency between two cursor time 
YDlues RI tZR seleFteG grDShs. )Rr e[DPSle� the first YDlue FRulG Ee T� RI &hDnnel � 
and the second could be T1 of Channel 1.
1. To calculate the latency value between two selected points, click Channel Math

menu (from Analysis window) and select Latency. This pops up a window. Click 
OK. Now, you can place T1 FursRr LnGeSenGentl\ Ln GL΍erent FhDnnels. PlDFe the 
cursor as desired.

2. To calculate the latency value between the two selected points, click on the 
Graph Math menu (of the Analysis window) and select Latency. The Latency 
Value window appears.

�. /DtenF\ YDlue Ls GLsSlD\eG Ln /DtenF\ ZLnGRZ. <Ru FDn Iurther finG the YDlue Rn 
the right top of corresponding channel.

4. Press Close to close Latency Value window.
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Fig. 78—The Latency Value window allows you to calculate the latency value between two 
points on two different channels.

Restoring Defaults
When necessary, you may reset the graphs and the cursors to their original portions. 
This deactivates any cursors that have been set. 
1. Click on the Channel Math menu (of the Analysis window) and select Default. 

The Default Signals window appears (Fig. 79).

Fig. 79—The Default window lets you return to your original data display.
2. Use the arrows next to the Select Channel fielG tR seleFt D sLngle FhDnnel Rr Dll 

channels. channels. By setting Multiple Channel checkbox ON, you can restore 
the data display of the multiple channels that you like.

3. Click Close.

Running Standard Statistical Calculations
To calculate the standard statistical values of all of the sampled data, click on the 
Statistics menu (of the Analysis window). The calculation is performed on the data 
between the selected (positioned) cursors. This calculates the mean, minimum, 
maximum, standard deviation and median values of all graphs. The values display in 
the Get Statistics window (Fig. 80). 
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Click Save EuttRn tR sDYe the file Rr FlLFN Close button to close the window.

Fig. 80—The Get Statistics Window displays the standard statistical values for all sampled 
channels.

SPECIFICATIONS
ThLs unLt FRnIRrPs tR the IRllRZLng sSeFLfiFDtLRns�

Number of Inputs ...........................................................................................................8 Analog
ADC Resolution ................................................................................................�� ELt� ���Ɖ9�ELt
Maximum Sampling Rate.................................................... 400 ksps aggregate in AI mode

10 ksps/channel (software limited)
Input Connections.............................................................................................................. 8 BNC
Input Impedance ..................................................................................................................� MŶ
Input Range.............................................................................................................+10V to –10V
System Noise ...............................................................................................................<1mV RMS
Digital Input/Output............................................................................................................16/16
Power Source ..................................................................................................................... 12VDC
Operating Current.........................................................................................800mA maximum
PC Interface.......................................................................................................................USB 2.0
Digital and Analog Inputs..................................................................................Maximum: 30V

Minimum:–30V
Logic High Voltage...............................................................................................2.3V minimum
Logic Low Voltage...............................................................................................1.0V maximum
Analog Outputs .............................................................................................................................3
Resolution............................................................................................................................ 16 bits
Output Range .........................................................................................................+10V to –10V
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* Electrodes, batteries and other consumable parts are warranted for 30 days only from the date on which 
the customer receives these items.

WARRANTY
WPI (World Precision Instruments, Inc.) warrants to the original purchaser that this equipment, including 
its components and parts, shall be free from defects in material and workmanship for a period of 
one year* from the date of receipt. WPI’s obligation under this warranty shall be limited to repair or 
replacement, at WPI’s option, of the equipment or defective components or parts upon receipt thereof 
f.o.b. WPI, Sarasota, Florida U.S.A. Return of a repaired instrument shall be f.o.b. Sarasota.

The above warranty is contingent upon normal usage and does not cover products which have been 
PRGLfieG ZLthRut :PΖȇs DSSrRYDl Rr ZhLFh hDYe Eeen suEMeFteG tR unusuDl Sh\sLFDl Rr eleFtrLFDl stress 
Rr Rn ZhLFh the RrLgLnDl LGentLfiFDtLRn PDrNs hDYe Eeen rePRYeG Rr DltereG. The DERYe ZDrrDnt\ ZLll nRt 
apply if adjustment, repair or parts replacement is required because of accident, neglect, misuse, failure 
of electric power, air conditioning, humidity control, or causes other than normal and ordinary usage.

To the extent that any of its equipment is furnished by a manufacturer other than WPI, the foregoing 
warranty shall be applicable only to the extent of the warranty furnished by such other manufacturer. 
This warranty will not apply to appearance terms, such as knobs, handles, dials or the like.

WPI makes no warranty of any kind, express or implied or statutory, including without limitation any 
ZDrrDntLes RI PerFhDntDELlLt\ DnG�Rr fitness IRr D SDrtLFulDr SurSRse. :PΖ shDll nRt Ee lLDEle IRr Dn\ 
damages, whether direct, indirect, special or consequential arising from a failure of this product to 
operate in the manner desired by the user. WPI shall not be liable for any damage to data or property 
that may be caused directly or indirectly by use of this product.

Claims and Returns
Inspect all shipments upon receipt. Missing cartons or obvious damage to cartons should be noted on 
the delivery receipt before signing. Concealed loss or damage should be reported at once to the carrier 
and an inspection requested. All claims for shortage or damage must be made within ten (10) days 
after receipt of shipment. Claims for lost shipments must be made within thirty (30) days of receipt of 
LnYRLFe Rr Rther nRtLfiFDtLRn RI shLSPent. PleDse sDYe GDPDgeG Rr SLlIereG FDrtRns untLl FlDLP Ls settleG. 
In some instances, photographic documentation may be required. Some items are time-sensitive; WPI 
DssuPes nR e[tenGeG ZDrrDnt\ Rr Dn\ lLDELlLt\ IRr use Ee\RnG the GDte sSeFLfieG Rn the FRntDLner

Do not return any goods to us without obtaining prior approval and instructions from our Returns 
Department. Goods returned (unauthorized) by collect freight may be refused. Goods accepted for 
restocking will be exchanged or credited to your WPI account. Goods returned which were ordered 
by customers in error are subject to a 25% restocking charge. Equipment which was built as a special 
order cannot be returned.

Repairs
Contact our Customer Service Department for assistance in the repair of apparatus. Do not return 
goods until instructions have been received. Returned items must be securely packed to prevent 
further damage in transit. The Customer is responsible for paying shipping expenses, including 
DGeTuDte LnsurDnFe Rn Dll LtePs returneG IRr reSDLrs. ΖGentLfiFDtLRn RI the LteP�s� E\ PRGel nuPEer� 
nDPe� Ds Zell Ds FRPSlete GesFrLStLRn RI the GLɝFultLes e[SerLenFeG shRulG Ee ZrLtten Rn the reSDLr 
purchase order and on a tag attached to the item.



USA
International Trade Center, 175 Sarasota Center Blvd., Sarasota FL 34240-9258

Tel: 941-371-1003 • Fax: 941-377-5428 • E-mail: sales@wpiinc.com
UK

1 Hunting Gate, Hitchin, Hertfordshire SG4 0TJ
 Tel: 44 (0)1462 424700 • Fax: 44 (0)1462 424701 • E-mail: wpiuk@wpi-europe.com

Germany
Saarstraße 23, D-61169 Friedberg (Hesson), Germany

Tel: +49 (0)6031 1602171 • Fax: +49 (0)6031 1602180 • E-mail: wpide@wpi-europe.com
China & Hong Kong

WPI Shanghai Trading Co., Ltd.
Rm 18a, No8 Dongfang Rd., Pudong District, Shanghai, 200120 PR China

Tel: +86 21 6888 5517 • E-mail:chinasales@china.wpiinc.com
Brazil

 Av. Conselheiro Nébias, 756 sala 2611, Santos-CEP: 11045-002, São Paulo Brazil Tel: (013) 406-
29703 • E-mail: info@brazil.wpiinc.com

Internet
www.wpiinc.com • www.wpi-europe.com • www.wpiinc.cn • www.wpibrasil.com.br




